Thank you for purchasing a Panasonic product.
This document explains how to use the Smartphone Connect app. For information about the features of your phone system, refer to the Operating Instructions supplied with your phone system.

For U.S.A. users
For assistance, visit our Web site: http://www.panasonic.com/help for customers in the U.S.A. or Puerto Rico.

For Canada users
For assistance, please call 1-800-561-5505 or visit us at www.panasonic.ca
# Table of Contents

## Introduction
Smartphone Connect overview ............... 3

## Getting Started
Starting, exiting, and registering ............ 5
Screen layout ........................................ 5
Status notifications .............................. 6

## Phone Features
Making calls ....................................... 7
Using other features during a landline call .................................................. 7
Answering landline calls ....................... 8
Using other handsets ............................ 8

## Call Log Features
Viewing the call log ............................ 10
Making a call from the call log .............. 10
Adding information from the call log to your contacts .................................... 10
Erasing the call log ............................ 10

## Phonebook Features
Phonebook features ............................ 11

## Answering System Features
Turning the answering system on ............ 12
Playing your messages ......................... 12
Erasing all messages .......................... 12

## Other Features
Copying data to your phone system ........ 13
Copying contacts ............................... 13
Copying images (Android™ version only) .............................................. 14
Copying the ringtone (Android version only) ........................................... 14
Managing handset memory .................... 15
Changing sound settings ...................... 15
Changing status bar and notification settings ............................................. 16
Changing general settings .................... 16

## Registration Features
Registering your smartphone to additional base units ..................................... 17
Selecting a base unit ........................... 17
Confirming the wireless access point ....... 17
Deregistering your smartphone .............. 18

## Other Information
If you experience any trouble .................... 19
Error messages .................................... 19
Troubleshooting ................................. 22
Smartphone Connect overview

You can install the free Smartphone Connect app on your smartphone and use your smartphone as an extension of your phone system. The following features are available when using the app.
– Making and receiving calls using your landline
– Making and receiving intercom calls
– Playing answering system messages
– Checking your call log
– Copying contacts from your smartphone to your phone system
– Transferring landline calls between your smartphone and your handsets
– Copying images from your smartphone to your handsets to be used as wallpaper patterns (Android version only)
– Copying the ringtone from your smartphone to your handsets (Android version only)

Requirements

● A compatible Panasonic phone system (see below)
● A wireless router (IEEE 802.11g or IEEE 802.11n recommended)
● iPhone 4, iPhone 4S, iPhone 5, iPad, or iPad mini (iOS 5.0 or later)
   or
   An Android device (Android 4.0 or later)*1
● The Smartphone Connect app; download information is available at the web page listed below

www.panasonic.net/pcc/support/tel/air

● You must configure both your base unit and your smartphone to connect wirelessly to your home network via your wireless router. Refer to the Operating Instructions supplied with your phone system for more information.
● In order to use most of the app’s features, your smartphone needs to be connected to the same wireless router as your base unit. (You cannot use these features while away from home.)
*1 Minimum recommended screen resolution: 1280×720. Screen text may not be displayed properly when using a screen with lower resolution.

Functionality information

● The app may not function properly depending on system environment, such as your smartphone model, peripherals connected to your smartphone, and the apps installed on your smartphone.

Compatible Panasonic phone systems

– KX-PRW120

Other information

● Design and specifications are subject to change without notice.
Introduction

- The illustrations, screenshots, and product interface text shown in this document are for reference only and may differ from the actual product.
- The suffix is omitted from model numbers listed in this document.
- Mobile phone call features are not available when using iPad or an Android device that does not support mobile phone calls. Other features may not be available depending on your device’s specifications and limitations.
- This product contains Apache Commons Net 3.2, which is licensed according to Apache License Version 2.0. The license is available for download at http://www.apache.org/licenses/LICENSE-2.0.html. Source code for this software is available at http://commons.apache.org/configuration/.
- The End User License Agreement (EULA) for the Smartphone Connect app is available at the following web page: www.panasonic.net/pcc/support/tel/air

Trademarks

- Android is a trademark of Google Inc.
- iPhone and iPad are trademarks of Apple Inc., registered in the U.S. and other countries.
- The Bluetooth® word mark and logos are owned by the Bluetooth SIG, Inc. and any use of such marks by Panasonic Corporation is under license.
- Wi-Fi® is a registered mark of the Wi-Fi Alliance.
- All other trademarks identified herein are the property of their respective owners.
Starting, exiting, and registering

Starting the app
Start the Smartphone Connect app by tapping its icon (shown below).

Note:
- The end-user licence agreement is displayed the first time you start the app.
- iPhone/iPad
  If your device is not compatible with the app, a message about incompatibility will be displayed when you start the app.

Exiting the app
iPhone/iPad
Exit the app using the multitasking bar.

Android
Tap  or press the menu button on your smartphone and then tap [Exit]. (The method for opening the options menu depends on your device.)

Registering your smartphone to the base unit
The smartphone can be registered to a maximum of 4 base units, and a maximum of 4 smartphones can be registered to each base unit.

Registering for the first time
The first time you start the app, the app will prompt you to register your smartphone to a base unit.

1 Make sure that your smartphone’s Wi-Fi feature is enabled and that your smartphone is connected to the same wireless network as your base unit.

2 Start the app.

3 When prompted to register your smartphone to the base unit, tap [Start].
   - The app searches for base units connected to the same wireless network as your smartphone. If no base units are found, you can tap [Search] to search again.
   - If there is more than one unregistered base unit connected to your wireless network, select the desired base unit, tap [OK] and then enter a name for the base unit and handset when prompted.

4 Wait for the registration process to end.
   - The app’s [Keypad] screen is displayed when registration has ended.

Note:
- After registration, you can confirm that the app is connected to the base unit by checking the status bar icon (Android version only) or notification (page 6).
- You can change the base unit name and the handset name assigned to your smartphone later if desired (page 17).

Registering to additional base units
See “Registering your smartphone to additional base units” on page 17.

Screen layout
The app contains the following screens. You can switch between screens by tapping the corresponding tab.

[Keypad]
Used to dial phone numbers and make calls using your landline.

[Call log]
Used to display a list of landline calls, including outgoing, incoming, and missed calls.

[Contacts]
Used to make calls to contacts stored in your smartphone.
Getting Started

Used to access other app features, such as answering system features, copying data from your smartphone to your handsets, changing settings, and displaying the app’s help files (Internet connection required).

Opening the options menu
The options menu is available on certain screens and provides access to additional features and settings.

**iPhone/iPad**
Tap [Menu].

**Android**
Tap ☰ or press your smartphone’s menu button. (The method for opening the options menu depends on your device.)

Status notifications

**iPhone/iPad**
Error messages and status notifications are displayed in the iOS Notifications Centre.

Additionally, ☳ is displayed in the [Keypad] screen if the app cannot connect to the base unit. Make sure the base unit is turned on and that the base unit and your smartphone are within range of your wireless router. See page 19 for more troubleshooting information.

**Android**
Error messages, status notifications, and the following icons are displayed in your smartphone’s status bar and notifications panel.

- ✈️ Indicates that the app cannot connect to the base unit. Make sure the base unit is turned on and that the base unit and your smartphone are within range of your wireless router. See page 19 for more troubleshooting information.
- 🔴 Indicates that there is a missed landline call.
- 📞 Indicates that there is a new message in the answering system.
- 📨 Indicates that the landline’s voice mail service has recorded a new message.
- 📞 Indicates that a landline call is being received.
- 📞 Indicates that you are talking on a landline call or have a landline call on hold. (Green icon)
- 📞 Indicates that another handset (or smartphone) is talking on a landline call or has a landline call on hold. (Red icon)

Indicates that the app is connected to a base unit and can be used to access features of your phone system.
Making calls
You can use the app to make landline calls, mobile calls, and intercom calls.

Important:
- Your smartphone must be able to access your base unit over the wireless network in order to use most features of Smartphone Connect. Make sure your smartphone’s Wi-Fi feature is enabled.

Dialing manually
1. Start the app and open the [Keypad] screen.
2. Enter the phone number.
   - To erase a number, tap [×].
   - To enter a dialing pause, tap and hold [•].
3. Tap [Landline] or [Cell phone] to select the line you want to use to make the call.
4. If you made a landline line call, tap [Disconnect] to end the call.

Note:
- If you are talking on a landline call and then receive and answer a mobile phone call, the landline call is either disconnected or put on hold, according to the [Landline call handling] setting (see “Changing general settings” on page 16).
- Make sure to tap [Disconnect] when ending a landline call, even if the other party hangs up first. Otherwise the connection to the landline will not be disconnected.
- If the base unit is busy when you try to make a landline call, you may hear a busy tone.
- If the base unit’s repeater mode is turned on, landline calls and intercom calls may be disconnected if your smartphone moves between the wireless range of the wireless router and the base unit.

Calling a contact
1. Start the app and open the [Contacts] screen.
2. Tap the desired contact, and then select the desired phone number if necessary.
3. Tap [Landline] or [Cell phone] to select the line you want to use to make the call.
4. If you made a landline line call, tap [Disconnect] to end the call.

Using other features during a landline call

Keypad
Tap [Keypad] during a call if you need to enter numbers, such as when navigating a call center’s voice guided menu system. To hide the keypad, tap [Cancel].

Audio output (speakerphone, Bluetooth, headset)

iPhone/iPad
Tap [Audio Source] to display a list of the available devices, and then tap the desired audio output device to switch to that device.

Android
Tap [Speaker] to turn your smartphone’s speaker on and off during a call. If a Bluetooth-compatible device is connected to your smartphone, tap the audio icon (speaker, Bluetooth, etc.) to switch between the available devices.

Mute
Tap [Mute] during a call to mute your smartphone’s microphone so that the other party cannot hear you. Tap [Mute] again to turn the mute off.

Hold
Tap [Hold] during a call to place the call on hold. Tap [Hold] to return to the call.
Phone Features

Flash

Tap [FLASH Call wait] during a call to use your phone system’s flash feature, such as to answer a call waiting or to switch between two different calls.

Answering landline calls

Answering a landline call

When you receive a landline call, the call receiving screen is displayed. Tap [Answer].

Note:
- Make sure to tap [Disconnect] when ending a call, even if the other party hangs up first. Otherwise the connection to the landline will not be disconnected.
- You can turn the ringer off temporarily by tapping [Ringer off]. Other handsets will continue to ring.
- To change the ringtone heard for landline calls and intercom calls, see page 15.
- **iPhone/iPad**
  If you want the app to receive calls even when it is in the background, turn the [Keep Alive in Background] setting on (see “Changing general settings” on page 16). When a call is received, your smartphone behaves according to the app’s sound settings (page 15) and the app’s volume. Note that your device’s ring/silent switch does not affect the app.
- **Android**
  When a call is received, your smartphone behaves according to its vibration and silent mode settings.

Using other handsets

Making an intercom call

1 Start the app and open the [Keypad] screen.
2 Tap [Intercom].
3 Tap the desired handset.
4 When finished, tap [Disconnect] to end the call.

Note:
- You cannot make intercom calls to other smartphones.
- **iPhone/iPad**
  When you are talking on an intercom call, the intercom call is disconnected automatically if you receive a mobile phone call.
- **Android**
  When you are talking on an intercom call, the intercom call is disconnected automatically if you answer a mobile phone call.

Transferring a landline call to a handset

1 **iPhone/iPad**
   While on a landline call, tap [Menu].
   **Android**
   While on a landline call, tap ‽ or press your smartphone’s menu button.
2 Tap [Intercom].
3 Select the desired handset, and then wait for the handset user to answer.
   - You can cancel and return to the call by tapping [Hold].
4 After the handset user answers, tap [Disconnect] to end your call and transfer it to the other handset.

Note:
- You cannot transfer landline calls to other smartphones.

Creating a conference call

1 **iPhone/iPad**
   While on a landline call, tap [Menu].
   **Android**
   While on a landline call, tap ‽ or press your smartphone’s menu button.
2 Tap [Intercom].
3 Select the desired handset, and then wait for the handset user to answer.
   • You can cancel and return to the call by tapping [Hold].

4 After the handset user answers, open the options menu and tap [Conference] to start the conference call.
   • You can talk to the outside party together with the other handset user.

5 When finished, tap [Disconnect] to leave the conference call.
   • The other handset user can continue to talk to the outside party.

Note:
• Only one smartphone can participate in a conference call.

Joining a call
If another handset is talking on a landline call, you can join the call by tapping [In use].
**Call Log Features**

### Viewing the call log

1. Start the app and open the [Call log] screen.
2. Tap the desired tab to view outgoing, incoming, or missed landline calls.

**Note:**
- The outgoing call log displays landline calls made by your smartphone only.
- The incoming and missed call logs display landline calls that were received only while your smartphone was connected to the base unit.
- After you view the information for a missed call, ⬇️ is displayed for that call.
- Calls that were blocked using the base unit’s call block feature are not displayed in the call log.

### Making a call from the call log

1. Start the app and open the [Call log] screen.
2. Tap the desired tab to view outgoing, incoming, or missed landline calls.
3. **iPhone/iPad**
   - Tap the desired phone number.
   - **Android**
     - Tap 📞 next to the desired phone number or person.

### Adding information from the call log to your contacts

1. Start the app and open the [Call log] screen.
2. Tap the desired tab to view outgoing, incoming, or missed landline calls.
3. **iPhone/iPad**
   - Tap ⬇️ next to the person or phone number you want to add.
   - **Android**
     - Tap the person or phone number you want to add.
4. Tap [Create new contact] or [Add to existing contact], and then follow the on-screen instructions.

### Erasing the call log

You can erase the outgoing, incoming, and missed call logs.

1. **iPhone/iPad**
   - Start the app and open the [Call log] screen.
   - Tap the desired tab to view outgoing, incoming, or missed landline calls.
   - 3. Tap [Menu].
   - 4. To erase all calls:
     - → Tap [Delete All Calls].
     - This option is not available for missed calls.
   - To erase selected calls:
     - → Tap [Delete Selected Calls], use the standard iOS method for selected items to be deleted, and then tap [Done].

2. **Android**
   - Start the app and open the [Call log] screen.
   - Tap the desired tab to view outgoing, incoming, or missed landline calls.
   - 3. To erase all calls:
     - → Tap ⬇️ or press the menu button on your smartphone, and then select the erase option.
     - Missed calls can only be erased one at a time.
   - To erase one call:
     - → Tap the call you want to erase and then tap ⬇️.
4. Tap [OK].
Phonebook features

iPhone/iPad
You can use the app’s phonebook features similarly to the way you use the contacts app of your smartphone.

Note:
- When using iPad or iPad mini, Smartphone Connect does not support adding or editing a contact’s picture.
- Many features of the app function by accessing the information stored in your device’s contacts. Depending on the software version of your device, a dialog may be displayed that asks whether you want to allow the app to access your contacts. You can change this setting later if desired in the privacy section your device’s “Settings” app.
- If you change the privacy setting, the app restarts. If you are on a call, the call will be disconnected, therefore we recommend changing the setting only when you are not on a call.

Android
Use the phonebook app included with your smartphone to add, edit, and erase contacts that are stored in your smartphone.

Note:
- To call a contact stored in your smartphone, see “Calling a contact” on page 7.
- To copy contacts stored in your smartphone to the base unit phonebook, see “Copying contacts” on page 13.
**Turning the answering system on**

1. Start the app and open the [More] screen.
2. Tap [Connect to answering system] → [Answer on].

**Playing your messages**

When your phone system has recorded new messages, \( \text{new messages} \) is displayed in the status bar (Android version only) and your smartphone’s notification feature displays a notification. To play back your messages easily, tap the notification and then use the playback controls described below.

1. Start the app and open the [More] screen.
2. Tap [Connect to answering system] → [Play].
   - Your phone system plays back your new messages. If there are no new messages, old messages will be played back.
   - The following operations are available when playing messages.
     - [Skip]: Plays the next message.
     - [Repeat]: Repeats the current message from the beginning, or plays the previous message.
     - [Stop]: Stops message playback and returns to the previous screen.
     - [Erase]: Erases the current message.
     - [Disconnect]: Stops message playback and exits the answering system.
     - [Audio Source] (iPhone/iPad only): Allows you to select a different audio output device for playback.
     - [Speaker] (Android version only): Switches between your smartphone’s speaker and earpiece. If a Bluetooth-compatible device is connected to your smartphone, tap the audio icon (speaker, Bluetooth, etc.) to switch between the available devices.
3. When finished, tap [Disconnect] to exit the answering system.

**Erasing all messages**

1. Start the app and open the [More] screen.
2. Tap [Connect to answering system] → [Erase all] → [OK].
Copying data to your phone system
You can copy various data stored in your smartphone to your phone system. When data is being copied, you can confirm the progress on the handset’s display.

Notes about copying data
- When copying, the estimated copy time is displayed. If network conditions change, it may take more time to copy the data.
- If a landline call is received while copying data, the copy stops. Data copied before the call was received is retained.
- A handset cannot make calls while it is receiving data.
- If file names include characters not supported by the handset, those characters will be replaced by “*” when they are copied.

iPhone/iPad
If the app is left in the background for about 10 minutes, any current operations will be canceled. When transferring data, make sure the app stays in the foreground until copying is completed.

Android
In order to use data copying features, your smartphone must either have an SD card or user-accessible internal memory.

Copying contacts
You can copy contacts from your smartphone to the base unit phonebook. When you copy contacts, name and phone number information is copied to the base unit, and contacts’ pictures are copied to the selected handsets.

Notes about copying contacts
- Only the first 16 characters of a contact’s name and 24 digits of a contact’s phone number are copied.
- If you have multiple phone numbers assigned to a contact, only the first 6 phone numbers are copied.

- Up to 500 contacts (500 phone numbers total) can be stored in the base unit phonebook. Pictures for up to 500 contacts can be stored in each handset.
- If a phonebook entry is erased from the base unit phonebook, its picture is not erased. You can erase it manually (page 15).
- Contacts with no phone number assigned to them will not be copied.
- Phone numbers stored using the international dialing symbol “+” will be converted according to base unit’s phone number conversion code settings. After you copy contacts from your smartphone to the base unit, confirm that the phone numbers were converted properly.
- If the base unit’s memory becomes full during the copy, the last contact copied successfully is displayed on the handset.
- If contact information includes characters not supported by the base unit or handset, those characters will be replaced by “*” when they are copied.

Copying specific contacts
1. Start the app and open the [More] screen.
2. Tap [Send contacts] → [Add to list].
   - Your smartphone’s phonebook app starts.
3. Tap the desired contact.
   - The selected contact is added to the list of items that will be copied. Tap [Add to list] to select another contact.
4. After you have added all the contacts that you want to copy, tap [Next].
5. If sending contacts that have pictures attached, select the handsets that you want to copy the contacts’ pictures to, and then tap [Send].

Copying all contacts
1. Start the app and open the [More] screen.
2. Tap [Send contacts] → [Send all] → [OK] → [Next].
3. If sending contacts that have pictures attached, select the handsets that you
want to copy the contacts’ pictures to, and then tap [Send].

Setting phone number conversion codes

If you store phone numbers in your smartphone’s contacts using “+” and the country code, we recommend that you store the following codes in the base unit.

International code
Store the international dialing prefix that you need to dial when dialing international phone numbers manually.

1 Using one of the handsets included with your phone system, press [Menu] (right soft key) #117
2 Enter the appropriate code (4 digits max.). → [Save] → [OFF]

Country code
Store the country code required when calling your country from overseas.

1 Using one of the handsets included with your phone system, press [Menu] (right soft key) #118
2 Enter the appropriate code (4 digits max.). → [Save] → [OFF]

Trunk prefix
If you store domestic phone numbers in your smartphone using “+” and the country code, store the number that should replace the country code when calling domestically.

1 Using one of the handsets included with your phone system, press [Menu] (right soft key) #119
2 Enter the appropriate code (4 digits max.). → [Save] → [OFF]

Important:
- After you copy contacts from your smartphone to the base unit, confirm that the phone numbers were converted properly.

Copying images (Android™ version only)

You can copy images from your smartphone to your handsets, and then use the images as wallpaper patterns.

1 Start the app and open the [More] screen.
2 Tap [Send wallpaper].
   - Your smartphone’s default image viewer app starts.
3 Select the desired picture.
4 Crop the image.
5 Select the handsets that you want to copy the picture to, and then tap [Send].

Note:
- 2 images to be used as wallpaper patterns can be stored in each handset.

Copying the ringtone (Android version only)

You can copy your smartphone’s current ringtone to other handsets.

1 Start the app and open the [More] screen.
2 Tap [Send ringtone] → [Send].
3 Select the handsets that you want to copy the ringtone to, and then tap [Send].

Note:
- Only your smartphone’s current ringtone can be copied. To copy a specific ringtone, first select that ringtone as your smartphone’s ringtone.
- Each handset can store up to 30 ringtone files or a total of 60 seconds of audio. File names are limited to 29 characters, not including the file extension.
- Only the first 60 seconds of a ringtone can be copied. Use a third-party audio editing app to shorten the desired ringtone before copying it, if desired.
- This feature only supports MP3 ringtones. If your smartphone’s ringtone is of another file format, it cannot be copied.
This feature only supports ringtones that are saved on your smartphone’s SD card or in its user-accessible internal memory. Built-in ringtones cannot be copied.

Managing handset memory
If you use your smartphone to copy images (used by your handsets as wallpaper patterns), pictures (attached to your smartphone’s contacts), or ringtones, you can confirm handset memory usage and erase unnecessary items to make more memory available.

Confirming memory usage
1 Using one of the handsets included with your phone system, press [Menu] (right soft key) #670
2 Confirm the information. → [OFF]

Erasing data from the handset memory
Erasing one item
1 Using one of the handsets included with your phone system, press [Menu] (right soft key) #670
2 [‹]: “Used” → [Detail]
3 [‹]: Select the type of data. → [Menu]
4 [‹]: “View” → [Select]
5 [‹]: Select the desired item. → [Erase]
6 [‹]: “Yes” → [Select] → [OFF]

Erasing all items of the same type
1 Using one of the handsets included with your phone system, press [Menu] (right soft key) #670
2 [‹]: “Used” → [Detail]
3 [‹]: Select the type of data. → [Menu]
4 [‹]: “Erase all” → [Select]
5 [‹]: “Yes” → [Select]
6 [‹]: “Yes” → [Select] → [OFF]

Note:
• If you erase a ringtone that was used as the handset’s ringtone, “Tone 1” (default) will be used instead.
• If you erase a ringtone that was assigned to a phonebook category, each handset’s ringtone setting will be used instead.
• If you erase a picture that was used as the handset’s wallpaper, “Wallpaper1” will be used instead.
• If you erase a picture that was assigned to a phonebook item, no picture will be displayed when you receive a call from that caller.

Changing sound settings

Ringtone settings
1 Start the app and open the [More] screen.
2 Tap [Settings] → [Ringtone] or [Intercom ringtone].
3 Select the desired setting.
   – [Default ringtone]: The app’s default ringtone is used.
   – [Select music]: The ringtone you select here is used.
   – [Silent] (iPhone/iPad only): No ringtone is heard.

Note:
• iPhone/iPad
Music files stored in your device can be used as ringtones; ringtone files stored in your device cannot.

Vibration and key tones (iPhone/iPad only)
1 Start the app and open the [More] screen.
2 Tap [Settings].
3 Under [Sound Settings] slide the on/off switches to the desired positions.
   – [Vibrate]: Your smartphone vibrates when a call is received.
   – [Keypad Tones]: Key tones are heard when you dial phone numbers.
Other Features

Volume settings (Android version only)

If the output volume for the speaker, headphones, etc. is too low or too high, you can use this setting to raise or lower the app’s master volume. We recommend you use this setting in conjunction with your smartphone’s volume controls.

You can also use this setting to raise or lower the microphone volume (i.e., the volume of your voice heard by the other party).

1. Start the app and open the [More] screen.
2. Tap [Settings] → [Volume].
3. Adjust the volume settings as desired.

Note:
• This setting cannot be adjusted while you are on a call.

Changing status bar and notification settings

1. Start the app and open the [More] screen.
2. Tap [Settings].
3. Under [Status bar notifications], tap the desired items to turn their check boxes on or off.
   - [Missed calls]: Determines whether status bar icons (Android version only) and notifications are displayed when there are missed calls.
   - [Answering system]: Determines whether status bar icons (Android version only) and notifications are displayed when the answering system has recorded new messages.
   - [Voice mail]: Determines whether status bar icons and notifications are displayed when the landline’s voice mail service has recorded new messages.

Note:
• iPhone/iPad
  If using the app’s notification feature, we recommend you keep the default settings in the iOS Notifications Center.

Changing general settings

1. Start the app and open the [More] screen.
2. Tap [Settings].
3. Under [General], tap the desired items to turn their check boxes on or off or select the desired settings.
   - [Auto launch] (Android version only): Determines whether the app starts automatically when you turn on your smartphone.
   - [Voice quality alarm]: Determines whether an alert tone is heard when voice quality becomes poor.
   - [Landline call handling]: Determines how landline calls are handled.
   - [Keep Alive in Background] (iPhone/iPad only): Determines whether the app can receive calls when the app is in the background. Note that turning this setting on can affect battery performance.

– Notifications Center: On
– Show 5 unread items
– Alert style: Banners
Registering your smartphone to additional base units

If the app is not registered to a base unit, use the procedure described on page 5.

1. Start the app and open the [More] screen.
2. Tap [Settings].
3. Under [Registration], tap [Register to base].
4. Select an unused base unit number and then tap [OK].
   - The app searches for base units connected to the same wireless network as your smartphone. If no base units are found, you can tap [Search] to search again.
5. If only one base unit is found: Continue to the next step.
   If more than one base unit is found: Select the desired base unit and then tap [OK]. When prompted, enter the required information and then tap [Done] or [OK].
6. Wait for the registration process to end.
   - The app’s [Keypad] screen is displayed when registration has ended.

Note:
- After registration, you can confirm that the app is connected to the base unit by checking the status bar icon (Android version only) or notification (page 6).
- You can change the base unit name and the handset name assigned to your smartphone later if desired (page 17).

Selecting a base unit

If you register your smartphone to multiple base units, this setting determines which base unit your smartphone connects to. If you have only one base unit, typically you do not need to change this setting.

1. Start the app and open the [More] screen.
2. Tap [Settings].
3. Under [Registration], tap [Select base].
4. Tap [Auto] or the desired base unit and then tap [Select].
   - When [Auto] is selected, the app automatically connects to a base unit based on the wireless network name (SSID) that the smartphone is currently connected to. When a specific base unit is selected, the app connects to that base unit only.
   - When [Auto] is selected, you can confirm which base unit the app is connected to by tapping [Details].

Note:
- To associate additional wireless network names (SSIDs) to a base unit, use the procedure described in “Adding a wireless access point” on page 18.
- After selecting a base unit, you can confirm that the app is connected to the base unit by checking the status bar icon (Android version only) or notification (page 6).

Changing base unit and handset name info

1. Start the app and open the [More] screen.
2. Tap [Settings].
3. Under [Registration], tap [Select base].
4. Select the desired base unit and then tap [Details] → [Edit].
5. Edit the information as desired and then tap [Done] or [OK].

Confirming the wireless access point

1. Start the app and open the [More] screen.
2. Tap [Settings].
3. Under [Registration], tap [Wireless AP].
   - A list of registered base units and the wireless network name (SSID) associated with each base unit is displayed.
Adding a wireless access point

If you expand your wireless network by adding a wireless access point that uses a different SSID than your wireless router, use this procedure to add the wireless access point to the app’s settings. This allows your smartphone to connect to the base unit when your smartphone is connected to the new access point.

Note:

- The app can store 10 wireless access points.
- This procedure is not necessary if the wireless access point uses the same SSID as your wireless router.

1. Make sure your smartphone is connected to the new access point.
2. Start the app and open the [More] screen.
3. Tap [Settings].
4. Under [Registration], tap [Wireless AP] → [Add to list].
5. Select the base unit that you want to associate with the new access point, and then tap [Select].

Deleting a wireless access point

Use this procedure only if you need to delete unnecessary wireless access points.

Note:

- You cannot delete a wireless access point if your smartphone is currently connected it.

1. Start the app and open the [More] screen.
2. Tap [Settings].
3. Under [Registration], tap [Wireless AP].
4. Select the wireless access point that you want to delete and then tap [Delete].

Deregistering your smartphone

Use this procedure to delete your smartphone’s registration from the desired base unit.

1. Start the app and open the [More] screen.
2. Tap [Settings].
3. Under [Registration], tap [Deregistration].
4. Tap the base unit that you want to deregister from, and then tap [OK] → [OK].
   - If your smartphone is not registered to any other base units, you will be prompted to register the smartphone once again. See “Registering your smartphone to the base unit” on page 5 to register.
If you experience any trouble

If you experience any trouble with the app’s features, first confirm the following.

- Are your base unit and wireless router turned on and functioning properly?
  → Refer to the operating instructions supplied with your wireless router for troubleshooting information if necessary. Make sure all cables are functioning and firmly connected.

- Have you configured the base unit to connect to your wireless router?
  → Refer to the Smartphone Connect Setup Guide or Operating Instructions supplied with your phone system for information if necessary.

- Is your smartphone’s Wi-Fi feature turned enabled?
  → Refer to the operating instructions supplied with your smartphone for troubleshooting information if necessary.

- Is your smartphone within range of the wireless router that the base unit is connected to?
  → In most cases, your smartphone cannot communicate with your base unit if they are not connected to the same wireless router.
  → Your smartphone cannot communicate with your base unit when you are away from home.

- Is there a problem with the quality of your wireless router’s signals?
  → Refer to “Wireless router signal quality” on page 23.

Error messages

General use

<table>
<thead>
<tr>
<th>Display message</th>
<th>Cause and/or solution</th>
</tr>
</thead>
</table>
| Unable to connect to the network.                    |  ● Your smartphone’s Wi-Fi feature is turned off.  
  E1-01                                               |  → Turn it on.  
  E1-02                                               |  ● Your smartphone cannot connect to your wireless router.  
  → Make sure your wireless router is turned on and functioning.                                                                                                                                 |
| Not connected                                        |  ● Your smartphone cannot connect to the base unit.  
  E1-04                                               |  → Make sure the base unit and your wireless router are turned on and functioning.                                                                                                                                 |
| The application could not start.                     |  ● Another app running on your phone is preventing this app from starting.  
  E1-05                                               |  → **iPhone/iPad**  
  Tap the home button two times and force this app to exit.  
  Quit other apps and then try to start this app again later.  
  → **Android**  
  Tap [OK] to exit this app. Quit other apps and then try to start this app again later.                                                                                                                                 |
| The maximum number of cellular phones is already     |  ● There are already 4 smartphones registered to the base unit.  
  registered to the base unit. E2-01                    |  → Use a handset to deregister any unused smartphones from the base unit.                                                                                                                                 |
| The base unit refused this connection.                |  ● There is a problem with registration information stored in the base unit.  
  E2-02                                               |  → Deregister your smartphone (page 18) and register it again.                                                                                                                                 |
  E2-03                                               |                                                                                                                                                        |
### Other Information

<table>
<thead>
<tr>
<th>Display message</th>
<th>Cause and/or solution</th>
</tr>
</thead>
</table>
| The base unit didn’t respond. Please use another handset to cancel the registration later. E2-04 | ● There was a problem when deregistering your smartphone.  
→ Use a handset to deregister your smartphone from the base unit.                                                                                                           |
| The base unit is not responding. E3-01                                           | ● There is a communication problem.  
→ Make sure that the base unit and your wireless router are turned on and functioning, turn your smartphone’s Wi-Fi feature off and then on again, and then try again.  
● The base unit’s IP address setting saved in your smartphone is incorrect.  
→ Confirm the base unit’s IP address, and then edit the base unit information stored in your smartphone (page 17) and manually change the IP address setting to match the base unit’s IP address. |
| Base unit is not selected. E4-01 E4-02                                          | ● Your smartphone has never connected to a base unit while connected to this wireless network.  
→ Use follow the procedure described in “Adding a wireless access point” to add the SSID (wireless network name) to the list of SSIDs associated with the base unit (page 18). |
| The wireless access point table is full. E4-03                                  | ● The app cannot save any more wireless access point settings.  
→ Delete unnecessary wireless access points (page 18) and then register your smartphone to the base unit again.                                                                                                               |

### Copying data to other devices

<table>
<thead>
<tr>
<th>Display message</th>
<th>Cause and/or solution</th>
</tr>
</thead>
</table>
| You cannot send preset ringtones. E5-01                                         | ● You tried to copy a preset ringtone to a handset.  
→ You can only copy ringtones that are saved on your smartphone’s SD card or in its user-accessible internal memory.                                                                                                       |
| You cannot send this ringtone. Please select an mp3 file. E5-02                 | ● Your smartphone’s current ringtone is not an MP3 file.  
→ Select an MP3 file as your smartphone’s ringtone.                                                                                                                                                                    |
| The file was not found on the SD card. E5-03                                    | ● The app could not find the current ringtone.  
→ Configure your smartphone to use a ringtone that is an MP3 file saved on your smartphone’s SD card or in its user-accessible internal memory.                                                                                                      |
| No response E5-04                                                               | ● The base unit or handset did not respond.  
→ Make sure each device is turned on and functioning.  
→ Make sure the DECT handset is within range of the base unit.                                                                                                                                                    |
<table>
<thead>
<tr>
<th>Display message</th>
<th>Cause and/or solution</th>
</tr>
</thead>
</table>
| Memory full                            | • The base unit’s or handset’s memory is full.  
  → Delete unnecessary data and try again. Note that if a phonebook entry is erased from the base unit phonebook, its picture is not erased. You can erase it manually (page 15). |
| E5-05                                  |                                                                                                                                                                                                                       |
| Communication error                    | • Wireless communication between the devices is poor.  
  → Make sure the relevant devices (smartphone, wireless router, base unit, handset, etc.) are within range of each other and that no objects are inhibiting wireless communication.  
  • The base unit is not receiving power.  
  → Make sure that the base unit is plugged in and is receiving power.  
  Android                                                                                          |
| E5-06                                  | • You tried to copy a ringtone that was too short.  
  → Select a ringtone that is more than 2 seconds long.  
  • You tried to copy a ringtone file that was too large.  
  → Select a smaller ringtone file.                                                                                                                                 |
| Busy                                   | • A call was received while data was being copied, or you selected a device that is on a call.  
  → Wait and try again.                                                                                                                                      |
| E5-07                                  |                                                                                                                                                                                                                       |
| Memory full Transfer was canceled.     | • Your smartphone’s SD card or user-accessible internal memory is full.  
  → Delete unnecessary data and try again.                                                                                                                  |
| E5-08                                  |                                                                                                                                                                                                                       |
**Troubleshooting**
Refer to the Operating Instructions supplied with your phone system for additional troubleshooting information.

### General use

<table>
<thead>
<tr>
<th>Problem</th>
<th>Cause and/or solution</th>
</tr>
</thead>
</table>
| Cannot make or receive landline calls, cannot use most app features | - Your smartphone’s Wi-Fi feature is disabled.  
  → Make sure that your smartphone’s Wi-Fi feature is enabled and that your smartphone is connected to the same wireless network as your base unit.  
  → **Android**  
    If your smartphone’s Wi-Fi sleep feature is configured to suspend (sleep) its Wi-Fi connection to save power, turn the sleep feature off.  
  - You added a new wireless router (or wireless access point) to your network. The SSID (wireless network name) assigned to the new device is different from the SSID of the wireless router that the base unit is connected to.  
  → Add the new wireless access point (page 18).  
  - You have changed the SSID (wireless network name) or password assigned to your wireless router, therefore the base unit cannot connect to your wireless router.  
  → Refer to the Operating Instructions supplied with your phone system and configure the base unit to connect to your wireless router, and then follow the procedure for adding a new wireless access point (page 18).  
  - Your wireless router’s client isolation feature is turned on.  
  → If your wireless router’s client isolation feature (a feature that prevents wireless devices connected to the same wireless router from communicating with each other) is turned on, your base unit and your smartphone will not be able to communicate with each other. Refer to the operating instructions included with your wireless router and make sure that this feature is turned off. |
| Busy tone is heard when [Landline] is tapped to make a landline call | - The base unit is busy. Wait and try again later. |
| Smartphone does not ring when [MEN] is pressed on base unit | - This is normal. When you press [MEN] on the base unit, handsets registered to the base unit will ring but smartphones will not. |
### Wireless router signal quality

<table>
<thead>
<tr>
<th>Problem</th>
<th>Cause and/or solution</th>
</tr>
</thead>
</table>
| Sounds cuts in and out when talking on landline calls                  | - These and other problems may occur if there is a problem with the quality of your wireless router’s signals.  
  → Refer to the operating instructions supplied with your wireless router and change its channel setting.  
  → If the problem continues, refer to the following.  
|                                                                      | - A microwave oven or other device that generates electrical radiation is interfering with the signals from your wireless router.  
  → Reposition your wireless router, smartphone, or the interfering device.  
  → Do not use the interfering device while you are using the app.  
| Noise is heard when talking on landline calls                          | - Several other devices (computers, smartphones, tablets, etc.) are accessing your wireless network at the same time.  
  → Wait and try again later.  
| Smartphone’s Wi-Fi connection drops                                    | - There are many other wireless networks in close proximity to yours.  
  → Reposition your wireless router.  
| Copying data from your smartphone to the base unit or other handsets takes a long time | - Objects such as walls, floors, ceilings, furniture, etc. are obstructing, reflecting, or absorbing wireless network signals.  
  → Reposition your wireless router or smartphone.  
  → Move any objects that may be causing the signal degradation.  
| Cannot connect to the answering system                                  |                                                                                                                                                     |
Please refer to the base unit’s operating instructions for sales department and customer support information.

Panasonic Corporation of North America
Two Riverfront Plaza, Newark, NJ 07102-5490

Panasonic Canada Inc.
5770 Ambler Drive, Mississauga, Ontario L4W 2T3

PNQP1013ZA CC0214MG0